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Documentation Retirement
In September 2021, EFILive retired the EFILocker COS Patch guide and replaced it with
the GM Controller Locking Guide.
The EFILocker COS Patch guide has not been updated since October 2016 and does
not document all current processes or supported operating systems. This guide has
been retained for historical purposes and EFILive recommends that users refer to the
GM Controller Locking Guide for the most up to date process documentation.

Introduction
This document is intended to assist EFILive customers with the basic operations and
steps necessary to remotely lock and unlock controllers using EFILive’s Auto-Lock
feature, specifically focusing on our exclusive EFILocker technology available on many
late model controllers up to and including the 2016 model year.
Due to the very different controller architectures that have been released over the past
20 years, Auto-Lock has been implemented differently for different controllers.
For late model controllers, such as the E92 and E39, Auto-Lock is implemented via an
EFILive developed Custom Operating System (COS) called the EFILocker patch.
Older controllers, such as the LS1, E38 and LB7 do not use the EFILocker technology,
instead they implement EFILive’s Auto-Lock features using our proprietary BootLocker
technology. This document is only concerned with EFILocker and does not discuss
BootLocker in detail.
Controller locking on 2017+ model year vehicles is not available due to GM security
changes.

What is Auto-Lock?
Auto-Lock is the new way to lock and unlock controllers. The two main benefits of AutoLocking are:
1. Tuners can configure their tuning files to remotely lock or unlock the target
controller when the file is flashed into a controller.
2. Controllers that have been Auto-Locked cannot be read but they can still be
reflashed.
Traditionally when an ECM is locked it cannot be reflashed by any tuning tool until it has
been unlocked. Only the original tuner was able to unlock the controller to allow it to be
reflashed. While that type of locking protects a tuner’s IP it also creates problems for
customers when their vehicle needs to be reflashed elsewhere. If the customer is no
longer able to visit the tuner’s shop or the original tuner is no longer in business or the
tuner simply refuses to unlock the controller then sometimes the only option is to
replace the controller.
Auto-Locking uses a modified locking strategy. When an ECM is Auto-Locked all nonEFILive reflashing tools (such as GM's TechII) will be prevented from reading and
flashing the controller. However EFILive’s Tuning Tool will always be able to reflash the
ECM. Depending on the Auto-Lock status of the file being flashed, the ECM will either
remain locked or be unlocked at the completion of the flash.
The Auto-Lock system generates and manages its own keys to ensure that any EFILive
user can reflash an Auto-Locked controller. Because the keys are managed internally
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and are never exposed to the user, the controller cannot be unlocked manually by
supplying the key.

What is EFILocker?
EFILocker is the underlying technology used to implement Auto-Locking on late model
controllers. It is a custom operating system (COS) developed and supplied by EFILive
called the EFILocker patch.

Additional Support Resources
If, after reviewing this guide, further assistance is required please contact the EFILive
Authorised Reseller from whom you purchased your product. They are your first point
of contact for EFILive support related inquiries.
If your question is in relation to the actual tuning of your vehicle (i.e. how to gain
performance, economy etc.) then please ask these questions on the EFILive Forum
(http://forum.efilive.com/). EFILive does not provide support or assistance for the actual
tuning of any supported vehicles.

Software Version Overview
EFILive presently has two major software versions (V7 and V8) that implement different
parts of the tuning and scanning process. The V8 software is undergoing significant
development and will eventually supersede V7 entirely for FlashScan V2 customers.
For the moment, however, both versions are required.
The following is a brief view of the activities that are performed with the different
software versions:
Software Version
V8

V7

Purpose
 Reads and Flashes all supported ECM’s.
 Maintains the bootblock and firmware versions for
EFILive FlashScan V2 and AutoCal devices.
 Standalone logging to FlashScan / Autocal.
 Reads and Flashes all historical ECM’s. (As additional
support is developed, read and flash functions are only
added to V8 software)
 Modifications to the ECM calibration are made using the
V7 Tune Tool application. The modified calibration is
then flashed into the ECM (again using V8).
 Applying the EFILocker Custom OS patch.
 Pass-thru logging of real time data from the vehicle using
the V7 Scan Tool application.

Supported Controllers
The EFILocker patch is available on the following controllers: Where the controller
remains in use in 2017+ model year, locking is not available.
Controllers
support@efilive.com
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A50
E39*/E39A*
E78*
E80

E92
E98
T43*
T87*

*Select Operating Systems only; refer to Appendix A, B, C and D for a list of
supported EFILocker patch operating systems.

How is EFILocker different to BootLocker?
The EFILocker implementation requires a custom operating system to be full-flashed
into the controller which means controllers that use the EFILocker implementation of
Auto-Lock can only be auto-locked and/or auto-unlocked during a full-flash procedure.
The BootLocker implementation does not require a custom operating system which
means controllers that use the BootLocker implementation of Auto-Lock can be autolocked and/or auto-unlocked during a calibration only-flash or a full-flash procedure.
Where the controller remains in use in the 2017+ model year, locking is not available.
The following controllers use EFILive’s EFILocker to implement Auto-Locking:
GM Gas Controllers
E39*/ E39A*
E78*
E80
E92
T43*

GM Diesel Controllers
A50
E98
T87*

Auto-Locking for controller using the EFILocker implementation may be applied to tune
files by:


Applying the EFILocker Custom OS Patch using the V7.5 Tuning tool software.

The following controllers use EFILive’s BootLocker to implement Auto-Locking:
GM Gas Controllers
LS1B
E38
E40
E67

GM Diesel Controllers
E54 (LB7)
E60 (LLY)

Auto-Locking for controller using the BootLocker implementation may be applied to tune
files in 3 ways;




V8 Scan and Tune using the [F3: Tune] -> [F4: Properties] via the [Security
Restrictions] tab.
V8 Scan and Tune via the [F5: BBX] -> [F6: Quick Setup] feature.
V7 Tune Tool via the [Permissions] tab.

Software Requirements
The EFILocker Custom OS Patch is a free software update to all EFILive customers.
To access these enhancements customers must be running the following software
versions:
1. EFILive V8.2.2.299 or later.
2. FlashScan V2 / AutoCal Firmware - V2.07.101 or later.
3. EFILive V7.5.7.307 or later.
support@efilive.com
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The latest software versions are available for download from the EFILive website.
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Licensing Requirements
FlashScan V2 licensing requirements MUST be met in order to flash a tune into a
controller. The GM Tuning Option must be enabled, and a VIN license for the target
controller (or the appropriate stream license) must be available on the FlashScan or
AutoCal device. If the ECM has already been licensed then the EFILive licensing
requirements are already met.



Tuning Options can be managed by opening the EFILive V8 Scan and Tune
software with your device connected and selecting [F7: Licenses] -> [F2:
Hardware].
VIN licenses can be managed by opening the EFILive V8 Scan and Tune
software with your device connected and selecting [F7: Licenses] -> [F3: VIN’s].

AutoCal end users DO NOT have access to create, edit or modify tunes. AutoCal end
users MUST contact the Tuner who’s FlashScan V2 their AutoCal is licensed to.
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Applying the EFILocker Patch
The following steps need to be followed to apply the EFILocker patch.
1. Before starting the EFILive V7 Tune Tool software, connect your FlashScan V2
to your PC to enable access to the EFILocker patch.
NOTE: If FlashScan V2 device is not connected prior to starting the V7 Tune
Tool, the patch will not be available.
2. Start the V7 Tune Tool software, and open the tune file that will be flashed into
the selected controller.
3. Apply the EFILocker patch by navigating to: View -> Show calibration window > [Upgrade OS], then click on the [Apply Upgrade] button.

4. Select the [Permissions] tab page in the same window.
5. Check the: "Always set the 'Auto-Lock' security restriction."
EFILive also recommends checking the "Always set the 'Cannot be Viewed or
Modified' security restriction."
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6. To save a file for flashing with FlashScan V2, select the menu option: File ->
Save tuning file as...
EFILive recommends using the "Save tuning file as..." option instead of the "Save
tuning file" to retain a pristine copy of your tune file because once the EFILocker
patch is applied and the file saved, the EFILocker patch can never be removed
from that file.
7. Uncheck the first two security restrictions.
EFILive recommends that you don't leave the first two security restrictions set all
the time, otherwise all files that you save will become security restricted and you
won't be able to open them using the V7 software.
To save a file for flashing with AutoCal, set the three AutoCal security restrictions in the
[Permissions] tab, as shown in the image below, and select the menu option: File ->
Save tuning file, for AutoCal.

Note: Because the EFILocker patch can never be removed from a tune file, the EFILive
V7 Tuning Tool software will continue to allow EFILocker files that have only the "AutoLock" security restriction set to be opened and edited. If the EFILocker file has any
other security restrictions applied (such as "cannot be viewed or modified") then it
cannot be opened or edited in the V7 Tuning Tool software. However, those other
security restrictions may be removed using the V8 software.
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Controller Locking Combinations
The Auto-Lock flag automatically decides if/when to full-flash and if/when to cal flash.
The flashing outcome of a tune file is dependent on the key criteria below.
1.
2.

The Auto-Lock status presently in the ECM.
The combination of the following security settings;
o Auto-Lock
o Calibration only flash restriction
o Full flash only restriction

The table below shows the locked/unlocked status after the respective flash operation is
complete.
NOTE: A50 controllers DO NOT permit calibration-only flashing when the controller has
been previously Auto-Locked.
EFILocker Controller Status

File Security Restrictions

Controller Not Yet

Controller Previously

Auto-Locked

Auto-Locked

Cal Flash

Full Flash

Cal Flash

Full Flash

None

Unlocked

Unlocked

Locked

Unlocked

Cal-Flash Only

Unlocked

Fail: $0539

Locked

Fail $0539

Full-Flash only

Fail $053C

Unlocked

Fail $053C

Unlocked

Auto-Lock

Fail $054D

Locked

Locked

Locked

Auto-Lock & Cal-Flash Only

Fail $054D

Fail $0539

Locked

Fail $0539

Auto-Lock & Full Flash Only

Fail $053C

Locked

Fail $053C

Locked

The locked or unlocked status of the ECM is only changed if the flash is successful. If
the flash fails, the previous locked/unlocked status is retained. The failed flash error
codes are:
$054D: Calibration only flashing is not allowed.
$053C: Tune file does not allow calibration flashing.
$0539: Tune file does not allow full flashing.
$054E: Target controller does not support calibration-only flashing with AutoLocking.
When a file containing the EFILocker patch is flashed into a controller that does not
already have the EFILocker patch installed, the user must select a full-flash option to
ensure that the EFILocker patch is installed into the controller's operating system.
If the user attempts a cal-flash when a full-flash is required the cal-flash will fail with
error $054D "Calibration only flashing is not allowed yet". Once the full-flash has
completed successfully and the EFILocker patch is installed into the controller's
operating system then subsequent flashes of any EFILocker files may be cal-flash or
full-flash.
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Tune File Security
The EFILocker patch is designed to prevent the contents of the ECM from being read
out and should be used with additional tune file security settings contained in EFILive
V8 Scan and Tune to fully secure tune files.

EFILive recommends that tune files should also contain the “Cannot be Viewed or
Modified” security restriction. NOTE: If this restriction is not set, anyone who has
access to the tune file can open, view and edit your tune file in the V7 Tune tool
software.
Customers should set reflash security settings most applicable to their need based on
the controller locking combination matrix, or allow both full-flash and cal-flash providing
instruction to the customer to full-flash in the first instance.
Device and Controller restrictions should be set based on business need. NOTE: Tune
files for AutoCal end users MUST contain Remote License, and should set the Device
license to prevent unauthorised FlashScan V2 devices from ‘sharing’ the tune.
Descriptions of security measures are documented in the EFILive V8 Reference.pdf
guide.
Security can be adjusted via editing each tune file in V8 Scan and Tune software, or
edited via the Quick Setup.
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[F3:Tune]
1. Connect FlashScan V2/AutoCal to your PC, and open EFILive V8 Scan and
Tune software.
2. Select [F3: Tune] and open the EFILocker tune file created in V7 software. The
following warning message will be displayed:

The Auto-Lock flag cannot be removed from the tune file, however other security
restrictions can be added/removed.
3. Select [F4: Properties] and “Clear All Security Restrictions”
NOTE: Clearing All Security Restrictions DOES NOT remove the EFILocker
Patch as confirmed by this warning.

This step gives the matching FlashScan device permission to add/remove
additional security settings.
4. Modify security settings and save the tune file.

support@efilive.com
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[F5: BBX] -> [F6: Quick Setup]
1. Connect FlashScan V2/AutoCal to your PC, and open EFILive V8 Scan and
Tune software.
2. Select [F5: BBX] ->[F6: Quick Setup]
3. Add the EFILocker tune file(s) created in V7 software.
4. To edit security settings, highlight relevant tune files and using the right mouse
click select “Reset Security Restrictions”.

NOTE: Clearing All Security Restrictions DOES NOT remove the EFILocker
Patch as confirmed by this warning.

This step gives the matching FlashScan device permission to add/remove
additional security settings.
5. Right click mouse and modify security by selecting the relevant security
restrictions.
6. Save the Quick Setup file.
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Practical Examples
Example 1 – Customer requires 3 individual tunes for an E92 controller via AutoCal and
the Tuner wants to lock the controller.
1. Create modified tunes for customer and apply EFILocker patch in V7 software.
2. Add the tune files to a Quick Setup in V8 software.
3. Select “Clear All Security Restrictions” and change security settings to:
o Cannot be Viewed or Modified.
o Can be Calibration or Full Flashed *Note: the first flash MUST be full flash,
but after the Locker Patch is installed, subsequent flashes can be calflashed.
o Set Device License to FlashScan’s License Number to prevent tunes from
being shared with other FlashScan V2 users.
o Link to Remote AutoCal to give AutoCal permission to flash.
o Set other security settings as needed (ie. Restrict flashing to a particular
VIN, or controller serial to prevent the same tune being ‘shared’ between
vehicles should the AutoCal user purchase additional VIN licenses.
4. Set other Quick Setup requirements e.g. Scan controllers and PID’s, Tune
controllers, device settings etc.
5. Save Quick Setup, Program AutoCal and send to the customer.
6. Instruct customer to full-flash their first selected tune. All future tune changes
can be cal-flashed.
Example 2 – You have a returning customer who requires a re-tune for an E92
controller in your workshop. You have previously installed Auto-Lock.
1. Create modified tune for customer, apply EFILocker patch in V7 software.
2. Flash the ECM using your FlashScan V2.
NOTE: Given your customer does not have a device they do not have a ‘hard
copy’ of the tune file. The Auto-Lock restriction prevents another device from
reading the ECM, so the tune file cannot be obtained or shared. All other
restrictions become irrelevant.
NOTE: In this scenario, Auto-Lock is optional provided cal-flash is selected. If
the file is not Auto-Locked and full-flash is accidently selected the ECM will
become unlocked.

Flash Requirements
The EFILocker patch can be flashed using standalone features in FlashScan V2,
AutoCal or via pass-thru mode using EFILive V8 Scan and Tune software and
FlashScan V2/AutoCal. The EFILocker patch cannot be flashed using V7 Scan and
Tune software.

How to Remove EFILocker from an ECM
EFILocker cannot be removed from a tune file. To remove EFILocker from an ECM, the
user must full flash the ECM with a tune file that does not contain the EFILocker patch.

support@efilive.com
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Appendix A – E39 & E39A EFILocker Status
The following table lists operating systems where the EFILocker patch is available.
E39 & E39A EFILocker Supported Operating Systems
12634130

12644447

12653091

12635812

12645364

12653345

12636334

12646098

12653570

12637158

12646099

12655008

12637495

12646128

12655477

12639993

12647088

12655479

12642404

12648433

12655481

12642405

12648907

12656454

12642817

12650103

12657779

12642819

12651855

12659671

12643377

12652815

12663375

The following table lists operating systems where the EFILocker patch is NOT available.
E39 & E39A EFILocker Unsupported Operating Systems

support@efilive.com

12647350

12655860

12664221

12650249

12656239

12666133

12651384

12657777

12666135

12651632

12657782

12668443

12651808

12658499

12669512

12652573

12659502

12666723

12653093

12661794

12667190

12654753

12663030
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Appendix B – E78 EFILocker Status
The following table lists operating systems where the EFILocker patch is available.
E78 EFILocker Supported Operating Systems
12640467

12647731

12654130

12643574

12649251

12655493

12644082

12653708

12645607

12653708

12646746

12654014

The following table lists operating systems where the EFILocker patch is NOT available.
E78 EFILocker Unsupported Operating Systems
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12663782

12657063

12663782

12647732

12657098

12669508

12655432

12659378

12669509

12655492

12662405

12677542

12656286

12663404
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Appendix C – T43 EFILocker Status
The following table lists operating systems where the EFILocker patch is available.
T43 EFILocker Supported Operating Systems
24267577

24270599

The following table lists operating systems where the EFILocker patch is NOT available.
T43 EFILocker Unsupported Operating Systems
24237276

24249833

24261871

24237685

24251030

24264142

24239353

24252573

24264923

24240291

24253414

24265260

24243170

24254909

24267571

24244551

24256025

24268005

24248859

24256125

24276633

24249042

24257301

24276638

24249179

24257135

Appendix D – T87 EFILocker Status
The following table lists operating systems where the EFILocker patch is available.
T87 EFILocker Supported Operating Systems
24271208

24274899

The following table lists operating systems where the EFILocker patch is NOT available.
T87 EFILocker Unsupported Operating Systems
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24274897

24279192

24280477

24278443

24280476

24281915

- 16 -

www.efilive.com

